
Components 

Power Switch located on the back of 

both the Attune and CytKick 
Always turn the CytKick on first! 

Attune CytKick 

• Compatible with many different 

standard plate formats, 

including 96-well, flat, round and 

V-bottom. 

 

• Option to pierce sealed plates 

 

• Round Bottom plates are 

recommended for optimal mixing 

 

• Performs automated cleaning 

between wells (from 1 to 10 rinses) 

and when the instrument is 

shutting down 



Focusing Fluid Reservoir 

1ml Sample 

Syringe 

Valve 

Fluid Lines 

Sensor Connections 

Waste Focusing 

Fluid 

Wash 

Fluid 

Shutdown 

Fluid 

Focusing Fluid Filters 

Attune® NxT Fluidics System 

Always reconnect fluid lines before sensor! 



IMPORTANT  

1) Connecting the sensor cable while leaving the fluid line disconnected may result in 

increased back pressure and introduction of air into the system. 

 

 2) The Attune® NxT Acoustic Focusing Cytometer must be idle before refilling the 

fluidics containers. 

 

3) Do not pull on the lines. 

1. Remove the sensor cable from the 

instrument 

2. Press the metal release buttons to free 

the tubing 

3. Fill or empty as needed with RT solutions 
 Large tanks – 1.8 L 

 Small tanks – 175 mL 

4. Reconnect the fluid line then the sensor 

line 

Filling (or emptying) Fluid Tanks 



Attune NXT Workflow 

Instrument Start-up 

Create experiment 

Experiment settings 

Compensation 

Data acquisition 

Data analysis 

Instrument shutdown 

Plate Acquisition 



Instrument Startup 

From power off  

1. Turn on CytKick first, remove cleaning plate 

and close tray door 

2. Turn on Attune, wait until status light is solid 

blue 

3. Network login 

4. Login Attune Software 

5. Launch start-up from instrument tab 

 

From Sleep mode (follows shutdown)  

1. Switch user – Network Login 

2. Close/restart Attune software - Login 

3. Remove plate from CytKick and close tray 

door if necessary 

4. Move Attune sample holder down 

5. Launch start-up from instrument tab 

Startup Complete 



Create Experiment 

Create new experiment or import previously saved experiment or template 

Select tube or plate experiment 

Create groups and tubes 

Select default workspace and 

instrument settings or load saved 

workspaces and Instrument 

settings 

Main menu 



Templates 

• Experiment Templates are directions for a new 

experiment that include workspace plots, run 

protocol, and instrument settings as defined by the 

user 

• Templates can be accessed from a single user 

profile 

• To create a template from a recorded experiment, 

select “Save as Template” from Home Tab or by 

right-clicking on user name in Experiment Explorer 

• To create a new experiment from template, select 

the “Templates” button located on the Main Menu 

desktop or from the Home Tab 

• Once a Template is created, it cannot be deleted 

 

 



Default Configuration mCherry Configuration GFP/YFP Configuration 

Confirm Optical Configuration  



DAPI 

2 

3 

Common Flurochromes for Attune 



Stain Index - AttuneTM NxT Flow Cytometer 

 

Reagent Laser Filter 

e660 637 670/14 

PERCP e710 488 695/40 

PE TX RED 561 620/15 

AF488 488 530/30 

PE AF700 488 695/40 

BV786 405 780/60 

APC e780 637 780/60 

BV711 405 710/50 

Reagent Laser Filter 

PE 561 585/16 

PE CY7 561 780/60 

PE CY5.5 488 695/40 

PE CF594 561 620/15 

PE e610 561 620/15 

PE CY5 488 695/40 

PE/DAZZLE 594 561 620/15 

BB515 488 530/30 

APC 637 670/14 

BV421 405 450/40 

AF647 637 670/14 

SB436 405 440/40 

Brightest Bright 

Freshly isolated PBMCs were stained with anti-human CD4 antibody 

conjugated to various fluorochromes then run on the AttuneTM NxT 

flow cytometer. Ranking of the fluorochromes was based on 

calculated stain index (SI) of the mean. Brightness was based on the 

following: Brightest SI 200+, Bright SI 100 – 199, Moderate SI 50 – 

99, Dim SI 0 – 49. It is recommended that antibodies be titrated for 

optimal performance in the assay of interest. 



Stain Index Continued 

Reagent Laser Filter 

SB702 405 710/50 

APC CY7 637 780/60 

SB780 405 780/60 

PERCP CY5.5 488 695/40 

FITC 488 530/30 

SB600 405 610/20 

V450 405 440/40 

BV785 405 780/60 

APC AF750 637 780/60 

e450 405 440/40 

AF405 405 440/40 

BV650 405 660/20 

BV510 405 512/50 

AF700 637 670/14 

Reagent Laser Filter 

SB645 405 660/20 

BV605 405 610/20 

APC H7 637 780/60 

PAC BLUE 405 450/40 

V500 405 525/50 

PERCP 488 695/40 

e506 405 525/50 

BV570 405 610/20 

PAC ORANGE 405 610/20 

Moderate Dim 

Freshly isolated PBMCs were stained with anti-human CD4 antibody 

conjugated to various fluorochromes then run on the AttuneTM NxT 

flow cytometer. Ranking of the fluorochromes was based on 

calculated stain index (SI) of the mean. Brightness was based on the 

following: Brightest SI 200+, Bright SI 100 – 199, Moderate SI 50 – 

99, Dim SI 0 – 49. It is recommended that antibodies be titrated for 

optimal performance in the assay of interest. 



 Choosing Parameters 

• Set to Automatically update Experiment level 1 

 

• Optional:  Load/export customized configuration 2 

 

• Parameters tab - select detectors (A-H-W) as 

required 

 

• Select fluorchrome label from drop down menu 

and enter target/marker name if desired 

1 

2 

• If compensation is required detectors can be 

selected through compensation setup 

 

• *Once compensation is recorded, all fluorescence 

channel voltages will be disabled 

 



2.  Adjust PMT Voltages 

 

• Adjust FSC & SSC voltages to position cell 

population on the scatter plot 

• Load default PMT Voltages (voltage walk 

values) from desktop folder and set as 

default 1 

• Reduce PMT voltages as necessary to keep 

fluorescence on scale 

1 



3. Adjust Threshold 

 

• Default setting: OR FSC - Between 50-100 

X1000 is a good starting point 1 

• Can be set on a single or up to 4 scatter 

and/or fluorescence channels 

• Data not meeting threshold criteria is 

permanently lost 

 

• Exclude coincident events option: 

•  checkbox 

At least 1 threshold must be set – typically the FSC .  If all 

are set to OFF, no data is displayed on the workspace!  

The “exclude coincident events” option can deal with the 2nd and 3rd types of 

coincidence where events showing a ‘valley’ (defined percentage of the pulse 

height/amplitude) are abort or thrown away 

 

1 



Compensation Set up 

Under the Compensation tab, click on Compensation Setup1. Or double-click on 

Compensation in Experiment Explorer2 

Source - tubes or wells 

 

Measurement – Area or Height 

 

Background fluorescence – negative gate vs. unstained control 

 

Compensation Parameters 

Compensation settings can also 

be dragged into a new experiment 

from a previous experiment 

1 

2 



Compensation:   Background Fluorescence Modes 

Auto Fluorescence Correction Choices: 

‒ Negative Gate 

‒ Unstained Control 

‒ None 

Background Mode When to Use? 

Negative Gate 
With different controls such as cells and beads; or using 

different cell populations (lymphs and monos). 

Unstained Control When all controls are of the same type (beads, all lymphs) 

None 
Rarely used but in cases  where background is negligible or 

cannot be ascertained. 



Example - compensation using unstained autofluorescence control 



  

 

   

  

1. Select sample to acquire 

2. Select automatically update experiment level run protocol 

3. Possible to load a saved run protocol 

4. Choose volume to acquire (minimum volume required 

is indicated as total draw volume which takes into 

account the dead volume) 

5. Select acquisition speed – normally between 12.5 and 200 

6. Choose between “stop options” 

7. After data is recorded the remaining sample can be returned 

to the tube 

1 

2 

4 

5 

3 

6 

Data Acquisition- Tube (Collection Panel) 



Spillover Matrix 

• At the end of Auto-compensation: 

‒ Spillover Matrix is automatically calculated 

‒ Compensation is applied to all samples 

Spillover      BL1-A           BL2-A            BL3-A           RL1-A    

BL1-A 

BL2-A 

BL3-A 

RL1-A 

Matrix assigns numeric value 

(percent spillover) of a fluorophore 

into other detectors. To read the 

matrix – fluorochromes in the 

column on the left spill into the 

detectors indicated on the top. Eg 

BL1A (FITC) spills into detector BL3-

A (5.86%) 



On Plot Compensation Adjustment Tools 

  

Tool allows manual adjustment of compensation 

*manual compensation must be used carefully to avoid adversely affecting results  

Drag populations to make 

coarse adjustments to 

compensation. 

 

Fine adjustments can be 

made using the %spillover 

dialogue box 

Use statistics to match relevant 

median populations 



How to view compensated data - Hyperlog 

Compensated data can be viewed in Hyperlog in order to see data that enters 

negative log space or is close to zero AFTER compensation is applied.   

  

 

   

  

Data piled up on 

the axes Log Hyperlog 

Once plot is selected the customize panel may be 

opened to change plot type and scaling 



HyperLog™ Scale 

• HyperLog™ 

• Logarithmic scale at the high end 

• Transitions to linear scale in the region around zero 

 

 

 

 

 

 

 

Used to better display fluorescence values on or below “0” that pile up on the axis 

due to measurement error when using a log scale. 

 

Better separation of dim signals 



Adjusting Hyperlog Setttings 

  

 

   

  

Correct Too small Too big 

1.To determine the most negative outlier set range to 

automatic then change the range to manual and set 

negative outlier as minimum value 

 

2. Use sliders to adjust the transition value  

 A large transition number will condense 

a spread population  

  A small transition value will spread out a 

population. 

1 

2 



When is sample recovery available?  

 

Anytime sample remains in the sample loop   

Stop option has been reached  

Operator clicks stop 

 

NOTE:  Must select  recover sample before lowering the tube lifter 

Sample Recovery - Tubes 



Attune NxT AutoSampler – Cytkick Max 

Specification CytKick Max Autosampler 

Plate types 

 

• 96 deep-well (flat, U-bottom, and V-bottom). 

• 96-well standard depth (flat, U-bottom and V-bottom) 

• 384-well standard depth (flat, U-bottom and V-bottom) 

• 384 deep-well (flat, U-bottom and V-bottom) 

• 1.5 mL and 2 mL microcentrifuge tube rack (up to 16 per rack) 

• Ability to create user defined custom plate definitions using 

specific plate dimensions 

Cooling Yes, passive using a cooling block for standard 96-well U bottom plate 

and microcentrifuge tube rack (up to 16 per rack)  

A standard plate is defined as a plate that is within the height range of 

14.35 mm ± 0.76 mm (such as Thermo Scientific™ 96-well Microtiter™ 

Microplates, Cat. No. 2205). 

Plate cover Foil covered 96-well (U-bottom only) 384-well ( U- and V-bottom only)  

mixing (limited by mixing efficacy) 

Mixing method Combination of aspiration and stirring 

based on the inputted sample volume, plate type, and well geometry 



Select Plates Dialog 

• The “Select Plates” dialog can be used 

to choose plates to add to the Quick 

Select plates list that is used to populate 

the Plate type list in a New Experiment. 

• It can also be accessed when setting up 

a new experiment by selecting Browse 

under the Plate type in the New 

Experiment Dialog 

 

 

 
 

• Using the Select Plates dialog, new, 

customizable plates, with plate specific 

dimensions, can be added and existing 

plates can be edited. 

• Custom plates can be exported and 

plates that have been created in a 

different version of Attune NxT software 

can be imported by appropriate option 

from the Import drop down 

 

 



Selection of cooling block or foil cover: New Experiment Dialog box 

• New checkboxes are visible when set to 

CytKick Max that allow the user to use a foil 

cover or cooling block 

• The cooling block option is enabled for 96 well 

plates For 96-well plates there is a universal 

cooling block for all plate types and also a 

cooling block for Thermo Fisher 2205 plate 

type 

 

• To use the cooling rack for 1.5 mL and 2 mL 

tubes  users should select the 16 well 

eppendorf rack for the plate type.  

• NOTE: to use the cooled 16 well tube rack it is 

not necessary to select Use Cooling Block 

option 

 

• NOTE: If using a Foil Cover it is important to 

indicate this in the experiment set up as the 

Mixing algorithm will behave differently if a foil 

cover is present. 



• The Test Plate function ensures that the CytKick probe 

position is in the correct location in all four corners of the 

plate. 

 

 

 

 

 

 

 

• The CytKick will move through each corner of the 

selected plate or tube rack and lowers the probe to the 

well depth as defined in the selected plate definition. 

This cycle is repeated three times. 

 

Test plate function 



Collection panel for CytKick 

Choose how wells are collected 

Select wells-right click to assign 

to group 

Select tubes to add to plate experiment-

right click to assign to group 

Choose mix settings 

Do not exceed minimum draw volume 



Mixing sample by aspiration instead of shaking ensures 

homogeneity of the sample and maintains cell viability 

The user sets: 

- The plate type 

- The total sample volume 

- The number of mixes  

(Max. 3 mixes, recommended at this time) 

 

The system defines: 

- The liquid level in well 

- The probe position 

- The mixing method 



• Mixing with the CytKick and CytKick Max involves a combination of mixing by 

aspiration and stirring. 

 

•  The volumes that are used for aspiration are dependent on the plate format and 

the sample volume defined in the software. 

 

• Three different algorithms are incorporated into the system for mixing and which 

algorithm is used is defined by the plate type automatically: 

SquareMoveAndBlast: Probe moves in a square pattern (including a 

center point, 1 mm above the bottom of the well 

CircularMoveAndBlast: Probe moves in a circular pattern, aspirates and 

dispenses at 5 locations, 1 mm above the bottom of the well using mix 

volumes specified for well volume  

CircularMove: Probe moves around well at specified radius without 

aspirating or dispensing (ie. Stirring the well) 

 

*If foil cover option is selected, there is no stirring, only mixing up and down 

 

 



Run Protocol Options  

• Optimize for High Throughput Collection: 

• 20 µL Acquisition Volume 

• 1000 µL/min 

• Enable Boost Mode checked 

• Stop on 20 µL  

• 1 Mix Cycle 

• 1 Rinse 

• Only used for rapid yes or no criteria 

 

• Boost mode is only enabled at 500 and 1000 µL/min and is used to 

increase plate processing speed which reduces the processing time 

for a standard 96-well plate from 45 minutes to 22 minutes 

• Increases carry-over between wells 

 

• Mix mode: 

• When the option is set as Standard, the Sample is mixed using the 

normal mixing speed 

• When the option is set to Gentle, the Sample is mixed and aspirated 

at a slower speed. For fragile cells, viscous samples, or samples 

prepared in viscous buffers, use the Gentle mix mode 

 

 



If “Optimize for High-Throughput Collection” is checked then automatically 

acquisition run and flow rate will be adjusted and “Enabled boost mode” 

will be checked as well 

 

*boost mode is only applicable for 500ul/min and 1000ul/min 

Optimize for High-Throughput Collection 



Sanitize Autosampler SIP 

Standard 

Deep Well 

• Between experiments and user 

• After running beads 

• If running DNA dyes 

• As part of shutdown procedure 



• The CytKick Max comes with three cooling blocks included: 

 Universal well plate holder: Expected duration of chill at 2-15°C, 64 minutes 

    Part number 100081492 

 

 Microtube cooling block: Expected duration of chill at 2-15°C, 108 – 120 minutes 

     Part number  100076823 

     Holds 1.5 mL and 2 mL Eppendorf tubes 

 

 Delrin microtube Holder: Expected duration of chill at 2-15°C, 27 minutes 

     Part number 100064241 

         Note: This item is not intended specifically for cooling and is more generally of use for running tubes without cooling     

         

 96-well round bottom plate holder: Expected duration of chill at 2-15°C, 95 – 100 minutes 

                    Part number 100063482 

                    For use with Thermo 2205 96-well U bottom plate 

Cooling block specifications 



Ribbons and Tabs 

More information in the SW user guide 

AAS 

Home 

View 

Instrument 

Autosampler 



Ribbons and Tab - continued 

More information in the SW user guide 

Workspace 

Compensation 

Overlay builder 

Statistics 



Setting User Preferences –under options 

Data analysis 



Data analysis – Managing the Workspace 

Toggle between Auto layout and Freeform 

panels can be unpinned and moved to different screen 

Set SSC width to 500 for doublet removal! 

Under the View tab different panels can be displayed 



Workspace - Plots 

Histogram – single parameter plot showing number and distribution of events  

 

Dot plot – two parameters plot where each axis represents the signal intensity of 

one parameter 

 

Density plots – two parameters plot where colors represent the density of a 

population of events with the same intensity 

 

Density precedence  – a combination of Dot and Density display.  A gradient is 

used to indicate the number of events within each of the plot bins and color is used 

to display the parent gate of events present. 

When a plot is highlighted the Customize Panel can be used to change plot titles, axis 

labels, axis scaling, plot type etc.  



Workspace – Gating Tools 

Regions are used to define areas to which statistics can be 

applied 

Gates are derived from regions used to establish population 

hierarchy's 

Pull-down menu to select gate 

Right click on region to create daughter plot 



Workspace - Derived gates 

• Gates can be customized by using Boolean logic (OR, AND, NOT, XOR) to 

link multiple gates together 

AND gates = all events that are 

shared 

 

OR gates = all events found within 

2 or more individual gates 

 

NOT gates = all events found 

outside the gate 

 
XOR gates = unique events found 

within an individual gates 

 

Note:   When naming a derived gate with two words, use parentheses to enclose both words. 

 

 Derived gates can only be created using regions. 



Results displays 

Visual Workspace plots Heat Map  

Statistics Results table Statistics box (on plot) 

Statistics export 

  - CSV spreadsheet 



Statistics Table 

 

 

 

 

 

 

 

 

 

• To display Workspace Statistics Table, click Statistics without selecting a plot. Workspace statistics 

contains data of all the gates in the Workspace. 

• To display Plot Statistics Table, select a plot in the Workspace and then click Statistics. Local statistics 

only displays data pertaining to the selected plot. 

• Alternatively, you can insert Statistics table by right-clicking on a plot or on the workspace, and select 

Insert Statistics 

• Prior to adding a statistics box, make sure the workspace has at least one plot. 

 



Customize Statistics  

 

• To customize Statistics table, select the Table and 

check statistics to display in the Statistics Tab 

 

 

 

• To customize Statistics value displayed on a plot, 

select the plot and choose the statistic 

 

 



Statistical Values 

• Count: Number of events collected 

• Events/µl: Concentration of events/µl in the gated region 

• % Total: Percentage of total events collected  

• % Parent: Percentage of a population based on the number of events collected in 

the parent gate 

• Mean: Sum of the signal intensities of a gate divided by the number of values 

• Median (50th percentile): signal intensity of a gate separating the higher half of a 

data population 

• Mode: signal intensity that appears most often in a set of data 

• SD: Standard Deviation, amount of dispersion of signal intensity around the Mean 

• rSD: Robust Standard Deviation, amount of dispersion of signal intensity around 

the Median 

• %CV: Percent coefficient of variation, Standard Deviation of the peak divided by 

the Mean of the peak, times 100 

• %rCV: Percent Robust coefficient of variation, Standard Deviation of the peak 

divided by the Median of the peak, times 100 

 



Sample Concentration 

The Concentration Statistic can be selected from the Statistics Ribbon 

 

 

 

 

• Values are displayed as Events/µL 

 

 

 

 



Export/Save of files as FCS 3.0 and FCS 3.1 

FCS 3.1 files are compatible with:  FlowJo V10+, Kaluza, FCS Express V4+   

FCS 3.0 files are compatible with:  FlowJo V7+, FCS Express V3+ and Kaluza 

Right click on the  experiment name or selected sample(s) and select “Export FCS file” from 

the drop down menu 

All experiment samples Selected experiment samples 

or FCS 3.0 (*.fcs) 



Instrument Shutdown 

Shutdown Function 

• Sanitizes the instrument 

• Cleans and rinses the fluid lines  

• Refills fluid lines with shutdown solution 

• Uses 3ml Coulter Clenz 
 

Ensures that: 

• Fluid lines refilled with a solution that prevents crystal 
formation and bubbles. 

• Once Shutdown starts, can log out of Attune software 

• CytKick will go to standby upon completion 



Note: Always wipe the outside of the SIP after doing a SIP Sanitize 

Between samples • Rinse – automatically initiated when SIP is lowered (for 

tubes), or set in run protocol for plates 

 

• Sanitize SIP between sticky samples or cell counts 

Between users / 

experiments 

 

  

1)  Unclog  then  Quick Deep Clean - 30mins cleaning routine 

(click on the arrow below the Deep Clean icon to select Quick) 

 

 

2)  Unclog then  2X Sanitize SIP / Sanitize Autosampler SIP 

(plate experiments) –  

              1st time with 3 mL 10% Bleach 

              2nd time with 3 ml Wash or De-bubble solutions   

End of day (3 steps)  

 

 

• Unclog 

 

• **SIP Sanitize with 1:3 dilution of Attune Flow Cell 

Cleaning solution ( Daily - if system runs ≥ 6 hr/day 

otherwise once a week) 

 

• Thorough Shutdown  (click on the arrow below the 

Shutdown icon to select Thorough) 

USE: 

1) if there is ≥30 min 

between users. 

 

2) If there is <30 min 

between  users. 

or 

Instrument Cleaning Guide 



• Operator/user 

De-select parameters not required to minimize file size 

***Do not clutter the Experiment Explorer  

 Close experiments not currently active 

  Export then delete experiments from the browser 

 Export experiments - .atx or .apx 

 FCS files – 3.0 or 3.1 format 



Concentration and Flow Rates 

Sample flow 

rate 

       Fastest              

  (35,000 ev/sec)    

maximum sample 

concentration  

Accurate counts 

       (8,000 ev/sec)        

   maximum 

sample concentration  

Cell size and flow rate recommendation 

1000 µL/ minute 2.1 x 106 cells/mL 0.48 x 106 cells/mL 
-  Particles > 4 µm 

-  Predominantly acoustic focusing 

 500 µL/ minute 4.2 x 106 cells/mL 0.96 x 106 cells/mL 

-  Particles > 2 µm 

-  Predominantly acoustic focusing 
 200 µL/ minute 6.7 x 106 cells/mL 1.5 x 106 cells/mL 

 100 µL/ minute 1.3 x 107 cells/mL 3 x 106 cells/mL 

  25 µL/ minute 5.4 x 107 cells/mL 1.2 x 107 cells/mL -  Small particles < 2 µm 

-  Predominantly hydrodynamic focusing 

-  Smallest sample core 

-  Best resolution from background for dimly positives 

assays 
 12.5 µL/ minute 1.0 x 108 cells/mL 2.4 x 107 cells/mL 

Note: Higher flow rates may show some loss of sensitivity 

When acquiring large event files (i.e files with > 106 events),  plot parameters should not be changed  while 

recording. 

The event rate will approach maximums stated in the column header when samples of stated concentrations are 

run at the flow rates below. 

Let your biology and data quality be your guide.   If good data is obtained while running at 

2-8,000 ev/sec, adjust the sample concentration and flow rate to maintain that. 



Fluidics Functions (on the Instrument tab) 

• Stop  - click to end any running routine. 

• Recover Sample - returns unused sample volume back to the well or the tube. 

• Rinse - flushes system between samples to minimize carryover. Rinse runs automatically 
every time the SIP is lowered, but it can also be user-initiated. 

• Sanitize Attune SIP - sanitizes the SIP and sample lines between sticky/dirty samples or 
experiments;  requires 10% bleach solution. Use wash solution instead if use beads. 

• Deep Clean - thoroughly washes the system sample lines and flow cell between sticky/dirty 
samples or experiments; requires 10% bleach solution (can also use debubble solution) 

• Startup - primes the instrument fluidics with Attune® Focusing Fluid. 

• Shutdown -  automatically cleans, sanitizes and shuts down the instrument. 

• Debubble - clears bubbles from the fluidics lines of the cytometer; Attune® Debubble 
solution required. 

• Unclog - back flush operation to remove clogs from the sample line. 

• Decontaminate System  - semi-automated decontamination of the Cytometer and the Auto 
Sampler fluidics.  



Sanitize SIP 

Quick wash/sanitize of sample line.   

Duration: 1 min. cycle time.  

Requires 3 mL 10% Bleach. Use wash solution instead if run beads. 

Run between users especially after sticky samples, DNA stains or beads.   

Deep Clean 

Sanitize system with bleach and wash solutions for selectable period of time. 

Three levels: Quick (10 cycles/ 25 min), Standard (20 cycles/50 min, Thorough 

30 cycles/75 min. 

Shutdown 

System clean and flush with bleach, wash, and shutdown. 

    Quick  10 cycles /30 minutes  Few samples 

    Standard  20 cycles/60 minutes  Immunophenotyping, apoptosis 

    Thorough  30 cycles/75 minutes  Samples with sticky dyes (PI), NLNW 

Instrument placed in stand-by (dream state) upon completion 

 

 Located under the instrument tab 

Cleaning Functions 



Plate experiments 

Can add tubes to plate experiment usually for compensation – these are indicated below the plate as T1, T2 etc 

Under the collection window, beside the record button is a pull down menu which allows the collection of either certain wells to all of plate or tubes within the plate experiment 

Can collect entire plate or selected wells 

To select wells click on the square box to the right of “collect wells starting from” – you can also use this to collect selected wells along with holding down the “ctl” key to select 

certain wells 

When using heat map with plates or tubes remember to select the “apply changes’ tab in the upper right area of the window. There is also the ability to create a default 

Can run comp from wells or plate.  

When select well or group of wells can right click to create a group. Can select a different group of wells –right click and create a different group- In the collection panel 

window can adjust collection settings and under the “apply to experiment tab” and select the group to which it will be applied or select as default collection settings. 

Can also save and export plate settings if you want to repeat 

 

Optimize for high throughput can only be used at 500-1000ul/min (note 1000ul/min is too high to be meaningful) –boost mode affects rinsing between washes and may result 

in some carryover 

 

Heat maps are useful when creating a visual reference for detecting change of a particular value for example above a certain percentage, in each well of a plate.  

 

Other stuff 

Very important- note when selecting draw volume be very careful to ensure that there is enough volume in the tube to accommodate the dead volume. In 

parenthesis to total vulume that is required to draw a selected amount is shown- best practice is to add 10% to that value  

Adding custom fluorochromes or filters to config- export new config to file to be imported by new user. Fluorescence protein config already sent to desk top folder “Attune”. 

baseline config, mcherry, no lyse,no wash. 

 

Possible to drag and drop IS,WS,CS from one experiment to next 

 

After voltage walk new voltage settings have been saved to optimal config along with a template that includes an experiment for adjusting target channels using flow set to set 

optimal MFI using new voltages. 

 

Experimental templates are found in manage templates tab 

 


